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Abstract
This tutorial should equip the reader with easy-to-follow best-

practices when it comes to using a DAZ character inside

Unreal Engine. It aims at generating a comprehensive

knowledge of the underlying procedure and is targeting an

audience with little to no prior knowledge in DAZ Studio,

Blender or Unreal Engine. Section primers are comprised of a

short summary or the main take-aways while certain sections

are tagged as (Deep Dive) indicating that they try to foster the

understanding of a subject aside from the DAZ-to-UE5 context

and can safely be ignored by professionals. Nevertheless, as a

beginner it might be useful to read the entire tutorial as some

explanations will be assumed in later sections. Modified DAZ

packages or UE assets are prepared for download as well as a

Blender Add-on aiming to drastically speed up your workflow.

Additionally, it will cover efficiency aspects for real-time

gaming such as mesh optimization and LODs which also affect

rendering times / computational requirements

Here is the promotion post 

highlighting the features of this tutorial

Here you can find the assets prepared for download
(If broken links get replaced, you will find them in the corresponding forum post here)

https://f95zone.to/threads/slumber-party-daz-to-ue-5-0-3-tutorial-promo-post.136420/
https://f95zone.to/threads/daz-body-with-metahuman-head-in-unreal-engine-5-0-3.136415/
https://pastebin.pl/view/ce7b1096


Limitations of this Tutorial
aka Should I Read it?

• The Neck Line
This tutorial concentrates on the DAZ character body and guides the reader to use a MetaHuman 

head instead. Since these are two different meshes with different skin textures and shaders, there 

will be a visible seam. My best efforts to reduce its visibility are outlined in their respective sections

with the corresponding outcome presented in the Comparison Renders section below. Be reminded 

that these are closeups; check the promotion video and focus on the neck area to evaluate its 

visibility in semi-closeups. Additionally I want to highlight the possibility to modify renders in post 

processing (Photoshop blending) and that the neckline will be barely visible in real-time game 

settings (but unfortunately in cinematics)

• Sharp Edges and Questionable Bending Behaviors
DAZ characters are optimized for Catmull-Clark shading which is currently not supported on 

imported skeletal meshes in UE 5.0.3. By applying a subdivision, we will mimic this behavior but 

only to a certain extent as this approach doesn’t upscale properly. Workarounds exist and are 

discussed in their respective sections, but it will still be slightly inferior in terms of realism.



Comparison Renders

(1) Neckline – Best Match of Skin Texture and Shader

Skin Asset: Samantha Skin (included in UE5 Skin Bundle)

MetaHuman Skin Parameters: UV = 0.39|0.63, texture = 0.2646

Skin Asset: Pavena Skin (included in UE5 Skin Bundle)

MetaHuman Skin Parameters: UV = 0|1, texture = 0.022



(2) Neckline – Iray Uber Skin Shader

Skin Asset: Hatsumomo (included in UE5 Skin Bundle) 

MetaHuman Skin Parameters: UV = 0|1, texture = 0.025

Skin Asset: Genesis 8 Female Default Skin

MetaHuman Skin Parameters: UV = 0|1, texture = 0.025



(3) Neckline – MetaHuman-like Skin Shader

Skin Shader based on MetaHuman head

Skin texture = Hatsumomo (included in UE5 Skin Bundle) 

MetaHuman Skin Parameters: UV = 0|1, texture = 0.025

Skin Shader based on MetaHuman head

Skin texture = Default

MetaHuman Skin Parameters: UV = 0|1, texture = 0.025



(4) Neckline – Character Creator 4 Skin Shader

Skin Shader from CC4 to UE5 with default cavity map

Skin texture = Hatsumomo (included in UE5 Skin Bundle) 

MetaHuman Skin Parameters: UV = 0|1, texture = 0.025

Skin Shader from CC4 to UE5 with default cavity map

Skin texture = Hatsumomo

MetaHuman Skin Parameters: UV = 0|1, texture = 0.025



I. DAZ Asset Setup
Section dedicated to what assets are used, why and what steps are needed to be taken in advance to 

make them usable in Unreal Engine 5

I.1 (Deep Dive) Morph Targets
This section outlines the general functionality and usage of morph targets as the DAZ Assets might 

not always be setup properly for use in UE5. Modified asset packages can be downloaded in section

I.2 

I.1.1 (Deep Dive) Morph Targets and their Use in Unreal Engine
Morph targets (aka blend shapes or shape keys) are the

shaping presents that many DAZ asset packages come

with (i.e. the sliders in the “Shaping” or “Parameters”

tab when having a Genesis character selected). They

allow to create unique variations of an existing mesh

while retaining the base model and its UVs - which is of

particular importance when it comes to customizable

characters and clothing: The clothing asset is aligned to

the base mesh and deformed the same way the morph is

(may require manual tweaking).

Furthermore, they often contain fixes for various

combinations of each other (like Golden Palace does)

enabling the artist to create new or enhance re-targeted

animations inside UE5. They are just additional, hidden

meshes placed onto the main mesh wherefore it will

decrease any game’s performance and increase render

times. Use only necessary morph targets or bake them

externally.

If you have used morphs inside DAZ to create a unique

character, these will get baked prior to exporting. So if

you have created a unique body shape, you don’t need to

export the morph to get its effect on the base model. However, if your model should have the ability

to gain weight or muscles in the course of your game, having these morphs is more efficient than 

multiple skeletal meshes. 

I.1.2 (Deep Dive) Make Most DAZ Morph Target Exportable

Even though described for Golden Palace in particular, this guide should apply to any asset pack 

that contains unexportable morph targets. Following this setup, DAZ will throw an error message 

“Duplicate formulas found” when loading a scene which is exactly what we are going to do and is 

safe to be ignored

Limitation: It seems that morph targets that actually are poses – i.e. the deformation is being 

calculated by a formula and is not an alternative mesh - can't be exported by this approach and 

have to be setup manually inside UE with a Pose Asset. All modified asset packages that I provide 

should solely contain exportable morph targets 



Problem: The morphs are attached to the “Golden Palace Gens” figure actor. Even though getting 

listed properly, these won’t get exported (neither to UE nor Blender, in any format). However, any 

morph that is directly related to the main figure’s geometry is exportable

Solution: Reparent the morph targets to the hip bone of the main figure’s geometry (or a respective 

bone). This will make the morphs useless until the related asset (here: “Golden Palace Gens”) is 

applied to the character

A. Making the DAZ Asset Files Readable
• Prior to installing, unzip the Golden Palace file and navigate to “Content” → “data” → 

“Meipex” → “GoldenPalace” → “GoldenPalace_Genitalia_v2” → “Morphs” → “Meipex” 

→ “Base” 

◦ The morph targets are always located in “Content” → “data” 

◦ If the asset package is already installed, you can find the exact location by clicking the 

gear icon (“Parameter Settings”) in the top right corner of any morph inside DAZ Studio

and examining the section “File Path” 

• Open a .dsf file in Numpad++ and if the text is encrypted, go back to DAZ Studio, select 

“Window” in the top left bar → “Panes (Tabs)” → “Batch Convert”

◦ Add your file directory, deselect all file extensions except DSF and make sure that 

“Uncompress Listed Compressed Assets” is selected at the bottom.

▪ Alternatively, click on “Add Files…”, navigate to your content folder and search for 

“*.dsf” in the Windows File Explorer and add all files from that search

◦ You won’t get any confirmation, but the files will be readable in Notepad now



B. Enable Auto-Follow Property
We want to setup a pointer for the actual morphs. Therefore we must ensure that the original morph

is able to receive any input from our pointers. By default, this is not the case, but most coders have 

it already enabled in their asset packs

• Have every .dsf file opened in Numpad++ at the same time and no other files

• Isolate the files that need to be adjusted by pressing “Ctrl + H” to open the find & replace 

window

• Search and replace ["auto_follow" : false,] by ["auto_follow" : true,]

→ If the coder has declared this variable already, we will adjust it accordingly

• Search for ["auto_follow" : true,] and replace it with the exact same but a white space (i.e. hit 

Spacebar once) at the end

• Hit “Replace in All Open Files”

• Do the exact same just the opposite way: replace the string with a white space at the end by 

the string that was there originally

• Save and close all files in Numpad (don’t just close Numpad, it will re-open the files next 

time you start it)

• In the Windows File Explorer, navigate back to the folder where your morph target files are 

in (or the search results window) and sort by “Last Edited”

• Select all files that have not been edited recently and re-open them in Numpad

→ These are the files we need to edit

• With “Regular Expressions” enabled in the bottom left of the “Search and Replace” window,

search for ["channel" : {] and replace it with ["channel" : {\n                "auto_follow" : true,]

◦ \n means line break; needed as we add another parameter to an existing function

◦ If you made a test in a single file before replacing in all files (recommended), be aware 

that the “Replace All” command will also overwrite the already changed one(s) so undo 

the changes to your testing file(s) manually

• Save all files again and close all windows



C. Create Copies for the Genesis Main Character Folder
• Copy all modified .dsf files and paste them in the following file directory of the asset pack 

(create it if necessary): [Content\data\DAZ 3D\Genesis 8\Female\Morphs\Meipex\

GoldenPalace]

◦ This way, files will appear on “empty” Genesis 8 bodies referencing the actual morph 

targets as a placeholder until a Golden Palace object has been added to the actor

◦ Rename the folder respectively for Genesis 8.1 or Genesis 9 characters 

=> All further steps are to be made to the copies only, not the original files

D. Reparent Morphs
• Open all copied files in Numpad at the same time with no other files opened

• We have to change the line ["parent" : 

"/data/Meipex/GoldenPalace/GoldenPalace_Genitalia_v2/GoldenPalace_2254_R.dsf#GoldenPalace",] to 

["parent" : "/data/DAZ%203D/Genesis%208/Female/Genesis8Female.dsf#geometry",] by going to the 

“Search and Replace” window in Numpad

• With “Regular Expressions” enabled, write ["parent" : ".*] into the search field

→ If just copying the above file path (i.e. not using regular expressions), you will miss some

morphs

• The replace field should contain the exact file path mentioned above (copied from a Genesis

8 Female Base Mesh file)

• By hitting “Replace in all open files”, every file will get updated

• Make sure that the amount of files you have opened (displayed in Windows File Explorer 

when selecting them all) matches the amount of overwrites Numpad has conducted (info 

text at bottom left corner of “Search and Replace” window after process completed)

◦ If for some reason not all files have been modified, check the others manually by sorting

them by “Last Edited”

E. (Optional) Assign Morphs to New Group
• Next I highly recommend to overwrite the group of the morphs for organizational purposes

• The group classification is listed in the .dsf file right before the vertex positions are listed 

(the long matrix of numeric values) and looks like this ["group" : "/7-Anus",]

• First, search for ["region" : ".*] and replace it with nothing to not have this line included twice

and mess up the script

• Search field: ["group" : ".*]

• Replace field: ["region": "Hip",\n            "group" : "/Golden Palace",]

◦ It will also work with a “region” that does not exist already (will be auto-created)

Don’t forget to hit “Save All” because just closing Numpad won’t save the files automatically!

=>  You can re-compress the .dsf files again to save disk space; uncompressed files won’t have any 

disadvantage except their file size

Now, either copy & paste the files in your DAZ Content Library or re-zip them, name them 

properly and install via DIM. The morph options should now be available whenever a character is 

selected even though changing their values has no effect until the corresponding actor is attached. If

it didn’t work, follow the re-install instructions in section I.2.1.



I.2 Important DAZ Asset Packages
Below, all DAZ assets are outlined that this tutorial will be based upon, but (easier-to-use) 

alternatives are referred to accordingly. I have conducted the required changes to the respective 

asset packs, providing download links to each one individually

I.2.1 Female Anatomy

I.2.1.1 Golden Palace (October 2021 Update)
SKU: 80057311

F95 Link: https://f95zone.to/threads/golden-palace-for-genesis-8-female-g8-1f-patch-v2-october-

2021-update.31217/

Used to add fully rigged genitalia onto the character. Rigging options and morph targets make it 

distinct from alternatives. Setup for “Genesis 8 Female Anatomical Elements” will be a lot simpler, 

but quality is inferior. Requires manual work for (i) making the morph targets exportable (section 

I.1.2) and (ii) getting rid of the GeoShells that are not supported in Unreal Engine (section IV.4) 

[Daz Studio 4.21 simplified this process drastically].

If you want to overwrite your already installed version of Golden Palace (instead of having both), 

uninstall via DIM, reset your content database, re-install & Re-Import Metadata.

https://f95zone.to/threads/golden-palace-for-genesis-8-female-g8-1f-patch-v2-october-2021-update.31217/
https://f95zone.to/threads/golden-palace-for-genesis-8-female-g8-1f-patch-v2-october-2021-update.31217/


I.2.1.2 Lifelike Nipple Graft
SKU: 63017

F95 Link: https://f95zone.to/threads/lifelike-nipple-graft-v1-01-updated-g8f.47429/

Most nipple assets are just a decal placed onto the main body texture. This one additionally deforms

the mesh and adds more detail, but the outlined approach is valid for any L.I.E. GeoShells (see 

section IV.4.1). Requires modification of the underlying body skin texture (in most cases).

Since I highly discourage you from exporting the nipple morphs to UE5 (just bake the nipples in 

DAZ!), I only provide you with a Nipple Bundle containing the “Lifelike Nipple Graft”, “High 

Resolution Physics Breasts” as well as the “HD Nipples for G8F”. The second asset can be used to 

quickly and easily adjust the skin texture of your choice inside DAZ Studio (see section II.1) while 

the latter solely offers a set of HD Nipple Textures that could be used to make the Lifelike Nipple 

Graft more detailed – if desired.

I.2.1.3 Skin Assets
SKU: Multiple

F95 Link: Multiple

The appearance of your skin texture largely depends on applied skin shader inside Unreal Engine. 

However, the default DAZ Skin or the ones from Skin Builder 8 are too grainy for my taste (see 

“Limitations” section for comparison renders). Therefore I created a collection of 6 different skin 

assets that can be applied with one click to your Genesis 8/8.1 figure (no head-related textures) in 

two versions: "Default" and "No Nipple". You will find them in your “Content Library” under 

“Genesis 8 Female” → “UE5 Skins”

https://f95zone.to/threads/hd-nipples-for-g8f-2-0.80736/
https://f95zone.to/threads/high-resolution-physics-breasts-for-g8f-g8-1f.129362/
https://f95zone.to/threads/high-resolution-physics-breasts-for-g8f-g8-1f.129362/
https://f95zone.to/threads/lifelike-nipple-graft-v1-01-updated-g8f.47429/


Skin color can (and needs to) be adjusted within the engine. Certain skin textures fit certain 

MetaHuman skin colors more consistently reducing the manual work and enhancing the quality of 

your renders (see Comparison Renders for parameter values). You are free to experiment with any 

skin you like, nipple adjustments are referred to in section II.1. 

I.2.2 Male Anatomy
This post discusses the feasibility of alternatives and why they haven't been included 

I.2.2.1 Dicktator
SKU: 57748 

F95 Link: https://f95zone.to/threads/dicktator-for-genesis-8-male-v0-3-g8m-g8-1m.20240/ 

Dicktator in conjunction with LK Morphs and Shapes, Pumping Pole and Texture Wizard currently 

is deemed the most useful asset package for male genitalia inside Unreal Engine. Its rigidity 

options, available modification packages as well as included morph targets provide a lot of 

flexibility and ease of use - even though it requires some effort to generate a realistic looking shape.

The general setup of the asset (phallus texture blending with the body skin) follows the one of 

Golden Palace allowing for the same UE material setup.

I.2.2.2 Male Skin Assets
SKU: Multiple

F95 Link: Multiple

Similar to the female skin assets, I have added a male version as well located in your “Content 

Library” under “Genesis 8 Male” → “UE5 Skins”. These come with their respective DAZ Male 

Anatomy texture and appear very smoothly inside UE5 

https://f95zone.to/threads/texture-wizard-2019-12.21464/
https://f95zone.to/threads/pumping-pole-palette-for-g8m-dicktator.86934/
https://f95zone.to/threads/lk-morphs-and-shapes-for-dicktator.86583/
https://f95zone.to/threads/dicktator-for-genesis-8-male-v0-3-g8m-g8-1m.20240/
https://f95zone.to/threads/daz-body-with-metahuman-head-in-unreal-engine-5-0-3.136415/#post-9488400


II. Character Creation in DAZ Studio
This section describes how to use the previously mentioned asset packs, provides some tips and 

tricks and covers a few caveats. DAZ professionals may still extend their knowledge by reading 

sections II.1 and II.4 (if intending to use a MetaHuman head)

Since DAZ Studio 4.21 is vital to follow the instructions in section II.3 when applying the Golden 

Palace GeoShell (or any other Custom UV GeoShell) to your character!

If willing to try the BPY script provided in chapter IV, make sure to first apply the Lifelike Nipple 

Graft and then the Golden Palace Shell using the GP Shell Fix script, not the one from Likelife

II.1 Remove Nipples from Any Skin Textures

Making use of Lifelike Nipple Graft or any other asset to replace the default nipples of your skin 

texture, you might need to get rid of the default nipples first as they sometimes overlap with (i.e. 

outline) your new nipples. Using kaluma’s DAZ Nipple Remover (included in the attached 

"Unofficial Nipple Bundle"), this can be done inside DAZ Studio without any image editing skills. 

You are free to skip this section if you are using the provided skin assets or you want to place bigger

nipple decals on top of the texture 

• The Breast Physics assets are located under “Content Library” → “DAZ Studio Formats” →

“My DAZ 3D Library” → “People” → “Genesis 8 Female” → “Anatomy” → “Nipple 

Bundle Unofficial” → “Physics HighRes Breasts” 

• With your figure selected, click on “Attach HR Breasts”, then “Copy Material” and then, 

finally, “Nipple Remover” 

• In the popup window, you can examine the effect of your changes on the underlying texture 

by disabling “Show Circle” and enabling “Show substitute” 

• The default settings will work in most cases, but if you need to make any changes:

• Size: Refers to the radius of the circle, i.e. the area to replace with pure skin 

• Horizontal and vertical offsets: If your nipple figures are not properly detected by 

the red circle, you can adjust the positioning this way 

• Substitute offsets: Adjust the quality of the replaced texture

• This asset places the same texture on top of the current layer overwriting only

the nipple area. By adjusting the offset, the second layer is moved accordingly

→ It might be worthwhile tweaking these settings for quality improvements 

• Color Correction and Opacity do as suggested, shouldn’t become relevant 

• The output folder is important, if hitting the button doesn’t open up your file explorer, you 

have to create said folder or the textures won’t get saved

• Find the required path by opening the .dsa script in the DAZ IDE

• From the top left toolbar, open “Window” → “Panes (Tabs)” → “Script IDE” 

• Enlarge that tiny window and navigate to the “Nipple Remover” script [[...]\

DAZ 3D\Applications\Data\DAZ 3D\My DAZ 3D Library\People\Genesis 8 Female\

Anatomy\Nipple Bundle Unofficial\Physics HighRes Breasts] 

• In the DAZ IDE, you will find the path for the generated textures folder in 

line 14 of the script 

• If the folder “GeneratedTextures” does not exist in 

[runtime/Textures/kaluma/PhysicsHighResBreasts/], you need to manually create it

https://f95zone.to/threads/high-resolution-physics-breasts-for-g8f-g8-1f.129362/


→ Remember that folder as you need to access these textures manually; the DAZ 

bridge does not import them (all) into UE5

=> It might take up to a minute for the textures to get generated and you won’t see a 

progress bar 

• Once the textures have been created, they are only applied to the GeoShell and not the 

underlying character 

• If you are okay with the HR Breast Nipples, you can skip to the next section of this tutorial 

• Delete the GeoShell from your Scene Panel

(top right corner in DAZ Studio) and select

your main figure 

• Under “Surfaces” in the bottom right panel,

expand “Surfaces” (last entry in list) and

select “Torso” (last entry in newly

expanded list) 

• In here you have to overwrite four textures

with the generated No Nipple versions in

the previously mentioned folder: “Base

Color” (usually a “D” in the image name

for “Diffuse [Color]”), “Translucency

Color” (usually “SSS”), “Glossy Layered

Weight” (usually “S” or “Specular”) and

“Top Coat Weight” (usually “S” or

“Specular”)

• Click on the image left to the slider

and choose “Browse”, navigate to

your generated textures folder and

replace the files accordingly 

• If your specific skin doesn’t have its

own translucency map, you might

want to use the default Genesis 8

Female one (create the No Nipple

version in advance for later use) 

• The Bump texture is not needed as

the Iray Material Function in UE5

uses normal maps instead

=> Assigning the No Nipple Skin

inside DAZ Studio is required as the nipple texture will be layered on top of the skin 

to create a new texture to be exported to UE5 



II.2 Setting up Lifelike Nipple Graft

This section is made for DAZ beginners, but outlines the process of using this asset on Genesis 8.1 

Females. Furthermore, lowering the opacity strength of the nipples texture is recommended as a 

value of 100% looks pretty harsh inside UE5. Remember to first apply the Lifelike Nipple Graft and

THEN the Golden Palace GeoShell

• Navigate to the “Content Library” and from there go to “DAZ Studio Formats” → “My 

DAZ 3D Library” → “People” → “Genesis 8 Female” → “Anatomy” [→ Unofficial Nipple 

Bundle]→ “Lifelike Nipple Graft”

• With your main actor selected, click on “1 - Apply Lifelike Nipple Graft”

• Genesis 8 figures can click on “2 – Apply Figure Material”, however for Genesis 8.1 

navigate to the “Surfaces” tab in the bottom right panel and navigate to the category 

“Genesis 8.1 Female” → “Surfaces” → “Body”



• Right-click on “Body” and select “Copy Selected Surface(s)”

• Paste the selected surfaces onto the category “Torso” under “Lifelike Nipples”

• With “Lifelike Nipples” selected in the Scene Panel, choose one nipple texture and double-

click to apply it on your DAZ character → This will take some time!

◦ If you are unhappy with the current selection, make sure to Ctrl-Z – otherwise multiple 

layers of textures will get applied causing trouble down the road

• In order to adjust the color intensity of the nipple, select “Lifelike Nipples” in the Scene 

Panel and navigate to the “Surfaces” Tab in the bottom right panel



• Under “Torso” → “Base”, click on

the icon for “Base Color” (left to the

slider) and select “Layered Image

Editor”

• Make sure that the “Likelike Nipple

[texture specifications]” is selected

and adjust the opacity (first slider in

bottom right panel). 80% is a good

start for most nipples

◦ Changes won’t be visible in the

viewport or popup window until

applied

◦ Do not try to drag the image in the

new window – it will move the

texture around!

◦ Hitting enter will auto-apply the

new value (same as pressing the

“Accept” button)

→ Applying the new value will

take some time

• Under “Parameters” in the bottom

right panel with your actor selected,

you can customize the shape of the

nipples

• It is intended to work with “00 – Nipples Erect” = 100%, but you can reduce the nipple 

length with parameter “11h – Nipple Shorter”

II.3 Setting up Golden Palace

• Navigate to the “Content Library” and from there go to “DAZ Studio Formats” → “My 

DAZ 3D Library” → “People” → “Genesis 8 Female” → “Anatomy” → “Golden Palace 

v2”

◦ For Genesis 8.1 characters, navigate to the sub-folder “9-Genesis 8_1” 

→ If it doesn’t exist, make sure to have downloaded the “Genesis 8.1 F Patch” and have 

it installed properly

• With your actor selected, double-click on “1-GoldenPalace_Genitalia_v2_Rigidity” as well 

as on “2-GoldenPalace_Shell_v2” (same name, but different files for Genesis 8 and 8.1)

• Apply the “3-GoldenPalace_Material Copy_v2”

◦ Genesis 8.1 has two options, select Version 4.9 (without “3-” in its name) otherwise will 

have a sharp line around the rectum shell. Can’t Ctrl-Z to undo if selected the wrong 

script, have to delete both Golden Palace Actors in the Scene Panel and start over

• With the “Golden Palace Shell” selected, apply the “4-Shell Fix” found in the main “Golden

Palace v2” folder



• When shaping your genitalia, pay attention to the changes in the underlying texture. The 

genitals might have a nice shape, but will look very unnatural in UE5 (or in a DAZ Render) 

if not outlined / blended smoothly with the skin texture

Important Adjustment in DAZ Studio 4.21+

We can save ourselves a big effort by applying the Golden Palace UVs onto the character inside 

DAZ Studio. As the “Ghost GeoShell Object” will have the same topology as the DAZ figure, but 

contain the default UVs, we no longer have to separate and rejoin the mesh in Blender resulting in 

additional clean-ups and slight distortions

• Select the object “Golden Palace Gens” that was

created by the first script – this is NOT the

GeoShell

• In the bottom right panel, select the “Surfaces”

tab and search for “uv”

• Change the UV Set from “Default” to “Golden

Palace” while the main branch is selected (i.e.

highlighted) in the panel left to it (right below

“Currently Used”)

=> This will mess up the textures inside DAZ,

but those have the be edited anyway in Blender

II.4 Preparation for MetaHuman Head

• Save your DAZ project as you might need to reload it later on

• Delete all assets that are attached to the head (tears, eyelashes)

• Select the main actor in the scene panel and navigate to the “Parameters” tab in the bottom 

right panel

• Find the setting “Head Propagating Scale” and set it to -99%. 

=> This way the head is hidden, but the neck is still visible allowing for a more dynamic 

overlapping with the MetaHuman head

• You don’t need a face texture as it won’t be visible in DAZ, but you need a head skin texture

which is already included in the body texture for Genesis 8 characters, but kept separated for

Genesis 8.1



III. Export Settings for DAZ Studio, Blender and UE5

This chapter covers the import and export settings for DAZ, Blender and UE5. We use the DAZ-to-

UE Bridge to auto-generate the proper materials for us, the actual character mesh needs to be 

optimized in Blender (chapter IV)

If you already have the DAZ to UE Bridge installed, just make sure to enable “Show FBXImport 

Dialog” in the UE project settings for this plugin. This gives you more control over the transfer 

between both programs

III.1 Setting up the DAZ to UE5 Bridge

• Download the file “dzunrealbridge.dll“ from the corresponding Github page

• Place the unzipped file in your DAZ plugins directory ([...]\Daz 3D\Applications\64-bit\

DAZ 3D\DAZStudio4\plugins)

• Open DAZ Studio, click on “File” in top left menu → “Send To …” → DAZ to Unreal

• Reveal the advanced settings, select UE5 as current version and click “Install Plugin”

• Navigate to a project folder and install the plugin

◦ Neither install the plugin for the entire engine or your final game project. It requires 

additional files and setup to publish a game with this plugin enabled so just use a 

temporary uproject and migrate finished DAZ characters to your actual game. Its not 

worth the effort and will make your final game larger in size

• Inside UE5, go to “Edit” → “Plugins” (top left menu), search for DAZ, enable it and restart 

the engine

• Navigate to the “Project Settings” (from “Edit” in top left menu), find “DAZ to Unreal 

Settings” in the left menu under “Plugins” and enable the option “Show FBXImport Dialog”

III.2 DAZ to UE5 Settings

Make sure that root of the character is selected before calling the bridge

III.2.1 DAZ to Unreal Plugin Panel

• Asset Type = Skeletal Mesh

• Export Morphs = disabled

◦ Will do them later. However, clicking on “Choose Morphs” allows you to save a .csv file

to easily load all morphs you want to be exported. This is essential since the other 

Morph Target Window is not very user-friendly

https://github.com/daz3d/DazToUnreal/releases


▪ Remove every entry under “Morphs to Export” (rightest column in panel) (Ctrl + A 

to highlight everything)

▪ Golden Palace morphs will be in a category related to Genesis 8 Female Hip since 

we have set them up earlier

• Many morphs are unrelated to the actual genitalia and can safely be ignored 

unless you have a pre-made character with a corresponding body adjustment 

morph

• The download link contains a ready-to-go preset for all 151 GoldenPalace morph

targets, however keep the total number as low as possible for your particular case

▪ Select the morphs in the middle column and click “Add For Export”

▪ Save this present and remember the file location

• Leave “Bake Subdivision” disabled. We are going to increase the mesh quality in Blender 

(section IV.5)



• Under “Advanced Settings” enable “Show FBX Dialog” and “Generate Normal Maps”

III.2.2 DAZ to Unreal FBX Dialog

• Format: FBX 2020 -- Binary (ASCII contains metadata that facilitates automation of tasks 

via Python; UE5.0.3 uses FBX version 2020.2)

• Objects: enable “Include Figures” & “Include Props” (as GeoShells are props)

◦ Disable “Selected Only” because GeoShells are unselectable by default

◦ Disabling “Visible Only” is not required, but a pre-caution measure if you have been 

working with the DAZ figure intensively

• Figures: Allow Degraded Skinning and Scaling as it is needed by UE to process the data

◦ “Followers” refer to JCMs (joint corrective morphs) that are auto-activated based on a 

bones position and are tough to be setup inside UE without further processing

• Modifiers: enable if you have any and import your .csv file by clicking on “Export Rules...”



• Texturing: Collapse UV Tiles is needed for UE materials to properly match the textures

=> If everything went well, you will have at least two entries in the penultimate panel at the 

bottom (Genesis 8.1 & GoldenPalace_Shell) and both state “Yes” in the “Export” column

III.2.3 Unreal Engine FBX Dialog

• Choose no skeleton as the skeletal mesh that gets created is not relevant, we only need the 

materials

• Disable “Create Physics Asset”

• Disable “Use T0 As Ref Pose”

• “Normal Import Method” = “Import Normals & Tangents”

• Uncheck “Import Animations”



• Disable “Import Textures” as Bridge creates them based on Iray Shading

III.3 Settings for Blender

• Export an .fbx file with the same settings as in section III.2.2 including the morphs if you 

have any

• Open Blender 3.2+, press “A” to select every actor in the scene and press “Delete” to get rid 

of them

• Import the .fbx file and disable “Use Pre/Post Rotation” under “Transform” settings



IV. Necessary Optimizations in Blender for UE5
GeoShells are currently not supported in UE 5.0.3 and need to be deleted. Likewise, surface

smoothing needs to be performed as Catmulk Clark Shading is not supported for imported meshes.

Lastly, we can apply some little tweaks to optimize the mesh for use in games

IV.1 Blender Add-on Usage Instructions

Sections IV.2 till IV.5 describe the required actions and tweaks needed to convert a DAZ figure for 

use in UE in great detail. However, if you like to use the add-on instead, here are the usage 

instructions to achieve the same result in much shorter time. The extensive sections, then, only need 

to be consulted for troubleshooting. The script accounts for a variety of scenarios (like custom 

naming of your character), but if you are using different GeoShells, you might need to make 

adjustments in the code itself (outlined in “[Coding]” paragraphs)

I wasn’t able to properly merge another urgently-needed script into mine wherefore you have to 

install two add-ons and use them sequentially

Install Instructions

• Download the zip file and in Blender 3.2+, navigate to “Edit” (top left bar) → “Preferences”

• In the new popup, select “Add-ons” from the left menu and hit “Install…” in the top right 

corner

• Select the zip file and wait a few moments until the scroll panel updates and only shows this 

add-on so that you can enable it

• You will find the corresponding panel under “Object Properties” (orange square in bottom 

right panel) → “DAZ Character to UE5” (requires an object to be selected)

=> Each button corresponds to an entire section of this chapter following the respective 

numeration

• Furthermore, install and activate the “Apply Modifier” Script in the same way



IV.1.1 Try Auto Detect

• This button is for convenience only, hitting it will run a script to fetch the respective bone 

chain names, main character and main GeoShell meshes as well as some of the textures 

required for baking

• It only works with the default setup



◦ It examines the main character root for the words “MALE” or “FEMALE” so if your 

using a pre-made DAZ character, your root might be called some name like “Kecy”

◦ It requires Golden Palace in combination with Lifelike Nipple Graft on Female 

characters or Dicktator on Male characters

=> If your character differs from the standard layout, you have to manually select the inputs 

(see section IV.1.2)

• It’s called “TRY Auto Detect” as it cannot work in 100% of all times so check each entry 

visually before executing the further scrips

IV.1.2 Required Inputs

• Each of these fields require the corresponding input for the operations to execute properly

• The first three string input fields correspond to the respective bone chains outlined in the 

scene panel in the top right corner

◦ “LifeLikeNippleBone” will delete the entire bone chain so if you have any GeoShells 

that add useless bones (i.e. those not included in the standardized GP or DK skeletons), 

insert the name of the top tier parent here)

◦ “GeoShell Bone Chain” related to either Golden Palace or Dicktator and will delete the 

thigh bones (both, twist and bend) and reparent the pelvis to the main pelvis

• The following two boolean checkboxes are meant to account for specific occasions

◦ “Using MetaHuman Head?” will delete all bones and vertices related to the face leaving 

a whole in the mesh that is to be covered by the MetaHuman head

◦ “Skin Texture Includes Head?” will keep the material slot named “Head” separately 

instead of merging it since most Genesis 8.1 figures have a separate head texture which 

is not included in the body skin and therefore, require an additional material in UE5

IV.1.3 Rebone Operation

• Essential to be executed first 

◦ [Coding] It populates a list of names from the non-relevant GeoShell to be used to 

separate the main mesh for the UV transfer and texture baking

◦ [Coding] Script searches for a mesh that is not the correct GeoShell but whose name 

starts with the same 5 letters

• Apart from reparenting and deleting the GeoShell bones, it will reparent the “twist” bones to

mimic the skeleton setup of the UE5 Mannequin



◦ [Coding] It uses the sub-string “Thigh” to identify any “ThighTwist” or “ThighBend” 

bones that are created by the GeoShell object and will delete them as they have no vertex

weights associated to them

• Lastly, it conducts essential adjustments to the DAZ figures wherefore it has to distinguish 

between “Male” (i.e. Dicktator) and “Female” (i.e. Golden Palace w/ or wo/ Likelike) 

characters (see section IV.4.2.6)

◦ [Coding] Hip Adjustment for Female characters requires the faulty vertex group to be 

named “Hip”

◦ [Coding] Glans Adjustment for Male characters assumes the problematic vertex groups 

to be those listed in the global variable “lst_vertex_groups_names” and the vertices to 

examine to be included in the material slots “Glans” and “Shaft”

IV.1.4 Tidy Up Main Character

• Will check for and – if necessary – correct common naming issues

◦ [Coding] If material slot “Body” doesn’t exist, check if “Torso” does and if, first rename

to “Body” and second check if “Torso.001” (created by LifeLike) exists and rename to 

“Torso”

• Will remove (not merge) the unused material slots and the head vertices if the “Using 

MetaHuman Head?” bool has been enabled

IV.1.5 Clean Up GeoShell

• No longer needed

◦ Due to adjustments described in section II.3, the main character shape already has the 

correct UV assigned to it 

◦ The texture baking process has been outsourced to a separate project, please follow  

section IV.4.2.3.1 

IV.1.6 Increase Characters Resolution

• As indicated by its name, this is an optional step and only required if you want your 

character to look more HQ inside UE5

• Only use a subdivision level of 2 if you intend to follow the instructions in section IV.6.1.3

• If you have morph targets, select your main character shape, hit “Spacebar” and search for 

'Apply modifier for object with shape keys' (alternatively, select this option from the 

“Object” dropdown menu in the top left bar of the 3D viewport)

=> Since this is a lengthy process (~2.5s per morph target), you might want to open the 

console to keep track of your progress (top bar “Window” → “Toggle System Console”)

• Once the process has finished, export your character as .fbx file (settings in section IV.7) and

close the unsaved project file

IV.2 Skeleton Optimization



The objective of this action is to simplify animation retargeting from DAZ to UE5. If this step is 

ignored, the GeoShell will always remain at the same place causing unwanted distortions as the 

corresponding hip bone (that Golden Palace or Dicktator add) is not linked to the main hip bone of 

the DAZ character that gets animated. This can be solved with a “Copy Bone Transform” node in 

the AnimBP (target = hip, source = hip.002), but is rather inefficient for gaming. Same goes for the 

head vertices which, fortunately, can just be deleted (see section IV.3.2). Additionally, the IK Chain 

setup of UE5’s new retargeting system gets confused with the twist bones being included in the main

bone chain. Mimicking the setup of the Mannequin Skeleton, the bone hierarchy needs to be 

rearranged. 

By setting up a standardized skeleton for characters with genitalia, retargeting best practices can 

be created and animations can be shared with the community. Clean GoldenPalace and Dicktator 

skeletons are provided as a download, but the detailed usage instructions will be included in a 

separate animation tutorial



• Inside Blender, select the armature and go

to “Edit Mode” in the top left corner of the

3D Viewport (default is “Object Mode”)

• Expand every bone that is connected to

“Lifelike Nipple Graft”

• Ctrl+Click the first and last bone in the

entire list to select all

• Hover your mouse over / into the 3D

Viewport and hit the “Delete” key and

select “Bones”

• Expand the Bone Hierarchy of Golden

Palace or Dicktator twice and click on the

bone “pelvis.002”

• Navigate to the bone tab in the bottom

right panel (green bone icon, last in list)

and click into the “Parent” dropdown menu

• Assign the bone “pelvis” as its new parent

and delete the other two bones

(“GoldenPalace” / “Dicktator” and

“hip.002”) that are not connected to

“pelvis” anymore

• You need to rename this bone to

“GP_Pelvis” or “DK_Pelvis” as it won’t be

recognized by UE5 otherwise

• Additionally, rename the main armature

object (“Genesis8_1Female”, orange

mannequin icon, not green one) to

“Genesis8_Root”

→ If you are using a pre-made DAZ

character, it might be named differently

• Furthermore, as the head isn’t retargeted

by default anyway, we can delete any

bones that are parented to the “head” bone

◦ If intending to use a DAZ head, you

would have to setup a facial rig for

retargeting or LiveLink

◦ Expand the bone hierarchy and select

every bone that is parented to “head”

and delete them (keep the bone

“head”!)



IV.3 Tidying up the Material Slots

Depending on your project, it might be useful to tidy up your material slots by deleting unused ones

or merging multiple slots into a single one. Instructions for GeoShells will be covered in the next 

section

IV.3.1 General Approach

• With the respective object selected, go to edit mode (shortcut: Tab) and deselect all vertices 

by right-clicking in the 3D viewport in an empty space

→ When successful, a black grid will be displayed without any orange dots

• Under “Material Properties” in the bottom right panel, click on a material slot and hit 

“Select” to highlight all corresponding vertices in orange color

(Deep Dive) Figure out which slots can be merged

• This entirely depends on the underlying texture and the UV Islands

• With vertices selected, switch to “UV Editing” tab in the top bar

• The corresponding texture will automatically be displayed in the 2D Image Editor (left side 

of split-screen) as well as the UV Grid

=> Repeat this with every material slot you are unsure of, don’t do it with multiple ones 

selected at the same time

• By knowing which material slot uses which texture, select all material slot vertices with the 

same texture and examine if the UV Islands overlap with each other

◦ If the UVs use different areas of the texture, they are safe to be merged into one slot

Merge multiple material slots

• Click on the first material slot you want to merge and hit the button “Select”, repeat that 

with every other slot

• When all related vertices are selected (highlighted in orange in the 3D viewport), click on 

the main material slot you want to keep and hit the button “Assign” (it should have been 

selected first!)

=> Now all vertices are associated with this particular slot and the other ones can be deleted

Deleting unused material slots

• You have to switch back to Object Mode

• Select the material slot to be deleted from the scroll panel and click the hyphen (minus) sign 

right next to it



IV.3.2 If Intending to use a MetaHuman Head

• In Edit Mode, select all vertices of the following material slots: Face, Lips, Teeth, Ears, 

EyeSocket, Mouth, Pupils, EyeMoisture, Cornea, Irises & Sclera

• With them all highlighted, hit “Delete” in the 3D Viewport and select “Vertices”

◦ Since they have no corresponding bones anymore, these vertices won’t get animated 

causing a mesh distortion

• Go back to Object Mode and delete the corresponding material slots from the list

• For Genesis 8 characters: Assign the vertices of the “Head” to the “Body” and delete the 

head material slot

◦ To make the body material include the neck area, no need to have a separate slot for that

=> Genesis 8.1 characters have a separate texture to the head wherefore this material slot

needs to be kept 

IV.4 Handling Different Kinds of GeoShells

This section is written for “Likelike Nipple Graft” and “Golden Palace”, but should be applicable 

to any GeoShells that meet the further specified criteria

L.I.E. GeoShells already modified the underlying texture, thus only require a material slot cleanup 

and merge. Custom UV GeoShells on the other hand require a texture bake inside Blender in order 

to be used in UE5. Even though being more efficient, this approach doesn’t allow to make any 

detailed changes to the underlying texture in the editor so alternatively, you can copy the DAZ-like 

GeoShell setup by using multiple UV Maps – at the cost of performance



IV.4.1 Material Copying GeoShells (L.I.E. GeoShells)

GeoShells that just add another texture layer on top of the desired one. They will appear in the 

“Layered Image Editor” in DAZ Studio when selecting the base texture of the material-to-be-

copied (see second part of section II.2). All we need to do is delete the GeoShell, merge the material

slot and assign the modified texture in UE5

• These kind of GeoShells create a layered image by default which should be used instead of 

the original one

• In our case, the new texture is called “d.” followed by a number and is already imported into

UE5 (“Content” → “DazToUnreal” → [NameOfYourDazChar]→ “Textures”)

◦ If you have modified the opacity of the Nipple texture, two body textures will be created

◦ In case it was not imported: Select the corresponding object in Blender and move to the 

“Texture Paint” tab in the top bar

◦ Stay on the left side (with the 2D image) and examine all files in the dropdown menu 

when clicking on the picture icon until you have found the texture in question

◦ With the right texture selected (it will show in the window), click on “Image*”, select 

“Unpack” from the dropdown menu and choose “Overwrite” in the new popup

◦ Then, save the image on your disk and import it to Unreal Engine

• In Blender, make sure that the GeoShell Shape Object is selected and hit “Delete”

• Next, select the main “Genesis8_1Female.Shape” object in the top right scene panel and hit 

“Tab” to go to the edit mode

• Click in the 3D viewport to deselect all faces (character will turn from orange to black)

• On the right hand side, select the “Material Properties” and in the scroll panel, find the 

material slot that matches the shape of the deleted GeoShell (here: “Torso”)

• Follow the procedure outlined in section IV.3.1 to merge this material slot with the main 

body one



IV.4.2 Custom UV Overlay GeoShells

GeoShells that copy the underlying material, but instead of layering a texture, have their own one 

wrapped around customized UVs. Mimicking this blending process inside Blender allows to bake 

the texture and use the resulting image in conjunction with the Custom UVs inside UE5

IV.4.2.1 Identify Broken UVs

The instructions in this chapter require you to have valid UVs and for some GeoShells, these have 

to be created manually

• In most cases, you have two different UV sets for your GeoShell: one that extrapolates the 

underlying material (“DAZ Default UVs”) and one tailored to the GeoShell

→ The first one is most likely too dense for UE5, but we need the latter one anyway

• Export your character from DAZ to Blender and only export the GeoShell “[…].Shape” 

mesh with the settings outlined in chapter III

• Import this figure into UE and examine its UV Grid with no materials assigned

UVs that are properly matched onto the geometry (left) vs. problematic ones (right)



IV.4.2.2 (Deep Dive) Fix Broken UVs

If the UV Grid of your GeoShell is not accepted by the engine, you have to unwrap the UVs 

manually in Blender. Once a proper layout has been generated, you can save it inside DAZ Studio 

to facilitate your Blender optimizations

• After importing your character to Blender, you should have two GeoShell meshes with the 

default and custom UV Grid

• Select one mesh in the scene outliner (top right panel) and navigate to the “Object Data 

Properties” (green triangle) in the bottom right panel

• Expand the menu “UV Maps”, add a new one and make sure it is selected (i.e. highlighted)

• In the scene outliner, shift-select the other GeoShell mesh, hover your cursor into the 3D 

Viewport, hit “Spacebar” and search for “Transfer UV Maps”

• Deselect everything by right-clicking into the 3D Viewport, select the initial GeoShell mesh 

and navigate to the “UV Editing” tab in the top bar

• With all vertices of your mesh selected in the right split-screen (grid is orange and not 

black), switch between both UV Maps and examine the change in the left window

→ If nothing is changing, you have to reload the project and make sure to shift-select the 

meshes in the proper sequence

• Duplicate the custom UV Layout (second UV Map we have generated) by selecting it and 

adding a new UV Map 

Generating a Proper UV Grid

The simplest way is to separate the mesh into many separated parts, but this will impair texture 

editing and may cause visible texture seams in the engine. It is crucial to find a balance between the

grid’s density and the number of separated UV islands

• With all vertices selected in the “UV Editing” tab in the right window and with the duplicate

UV Map, hover the cursor into the 3D Viewport (right window of split-screen), hit 

“Spacebar” and either search for “Unwrap” or “Smart UV Project”

• The following instructions are meant to be a pipeline, i.e. only follow the subsequent step if 

the previous one doesn’t work in your case

◦ Smart UV Project: Will create feasible UVs most of the time, reducing the angle will 

increase the number of UV Islands, try with an angle of 90 degrees

◦ Unwrap: Simply unwrapping the UVs will most likely produce a too dense grid 

wherefore the mesh has to be separated by adding seams

▪ If your UV Grid already consists of separated UV Islands, you can generate the 

corresponding seams automatically



▪ Hover into the UV window (left screen) and hit “A” to select the entire UV Grid

▪ Hit “Spacebar” and search for “Seams from Islands” – it will create read lines on 

your mesh in the right window

▪ Now unwrap your texture and check if it works in UE5

◦ Manually Adding Seams: If all previous steps fail to generate a feasible outcome, you 

have to scrutinize the shape of your GeoShell

▪ In the case of XY Male Genitalia, one can figure that the foreskin might be a 

problem as it is a dense area (i.e. the mesh has many vertices there) and intended to 

be inwards bound hampering a projection onto a 2D plane

=> There are many viable approaches to remedy this issue, but I will separate the 

glans from the shaft since both assimilate basic geometric shapes (cylinder and 

sphere) that Blender can handle with ease

▪ In the 3D Viewport, hide any other mesh in the scene by hitting the eye symbol next 

to it in the top right scene outliner

▪ With the mesh selected, hit “Tab” to go to object mode

▪ Optionally   increase the focal length of your camera if the mesh is very tiny or dense 

by hitting “N” in the 3D Viewport and selecting the tab “View” in the newly opened 

side bar to the right

▪ Make sure that nothing is selected by right-clicking into the 3D Viewport and 

checking the stats in the bottom right corner

▪ Ctrl-right-click each vertex node (i.e. the dot where the lines intersect) that should be

included in the seam making sure that you form a closed circle with your selection 

(last vertex node = first one)

• By shift-right-clicking a node that is not next to the previously selected one, 

Blender will pick the shortest path between both nodes



◦ With a circular node structure selected, hit “Spacebar” and search for “Mark Seam”

▪ It will work even if the selection is not circular / closed, but that seam will not be 

useful for the UV unwrapping

◦ With the glans isolated, we have to add a seam along (not across) the cylindrical shaft

▪ This time, the selection should include an existing texture seam node at the start and 

the end in order to be included in the unwrapping setup

▪ Adding the texture seam at the backside (i.e. not the top where you can see it from 

the front) will hide potential texture issues

◦ With these two additional seams created, navigate into the 3D Viewport (right screen), 

hover over any vertex, hit “L” to select all linked ones and in the collapsed menu in the 

bottom left corner, select the “Delimit” option “Seam”



=> This way you can apply different unwrapping methods for individual UV Islands

◦ We use the classic unwrapping methods as we don’t want the “Smart UV Project” to 

create additional seams

▪ With only the vertices of the shaft selected (see image above), hit “Spacebar” and 

search for “Cylinder Projection”

▪ All other islands can be unwrapped in the common way using “Unwrap”



Optimizing Your UV Grid

Depending on your unwrapping method, you might have to pack the islands to prevent 

overlappings. Furthermore you can scale the islands more efficiently and minimize the stretch / 

skew to facilitate its traversal to Unreal Engine

• With all islands unwrapped, move the cursor into the left screen of the UV Editing split-

screen and hit “A” to select all islands

• From the dropdown at the top, select “UV” → “Minimize Stretch”

• Wait a few moments and then click somewhere in the scene (tiny little info text will appear 

at the top left corner when being ready to click)

◦ It is asking for a blend factor that you can set with left-click, but we do not want to blend

between before and after, we want to keep the optimized result

• Optionally, expand the dropdown menu from the bottom left corner and expand the number

of iterations a little

◦ Will take some time to execute and effect is very subtle

• Next, with all your UV Islands selected, choose “UV” → “Average Island Scale” from the 

dropdown at the top and then “Pack Islands”

◦ If the islands are too dense for you (will be a problem if you intend to edit the texture 

manually), increase the margin from the pop-up menu at the bottom left

• With that all done, save the entire project as a .blend file

(Optional) Loading and Saving Your Custom UV Grid in DAZ Studio

This is not required as you could always just load up the Blender project file and manually transfer 

the UV Grid onto the newly created character. However, having it inside DAZ Studio will spare one 

step and facilitates the character creation process

• Open up your Blender project with the GeoShell and its three different UV Grids (default, 

tailored to GeoShell and created one)

• Delete both UV maps that you haven’t created and export the mesh as an .obj file

◦ Make sure to not pick the (experimental) option



◦ Leave the default export settings, but under “Geometry”, enable the last two entries 

“Polygroups” and “Keep Vertex Order”

• Inside DAZ Studio, just load the object into the scene (not the GeoShell, the object you 

would apply first to your character)

• With this one selected, navigate to the “Surfaces” tab in the bottom right panel and select the

object in the list

• Right-click on the actual tab (not the previously selected list entry) and choose “Load UV 

Set”



• Select your .obj file and assign a name to it

• Back in the “Surfaces” tab, with your object selected in the list, search for UV and assign 

the imported UV set

• Now, with your object selected in the top right scene outliner, click on “Save As…” → 

“Support Asset” → “UV Asset(s)”



◦ You can not change the asset path, but the Vendor and Product Name

◦ With your newly imported UV Set selected, you could furthermore compress the file to 

save disk space, but making it unreadable for Notepad++

◦ Once saved, you will find it in your DAZ Library in the “data” folder of the 

corresponding DAZ Asset Package

▪ In case of XY it can be found here: […]DAZ 3D\My DAZ 3D Library\data\db xxx\

XY\XY\UV Sets

• Whenever you load your asset from now on, it should choose the newly added UV Set 

automatically

◦ However, to make sure it keeps doing that, you can edit the values of […]\DAZ 3D\My 

DAZ 3D Library\People\Genesis 8 Male\Anatomy\dbxxx-XY\db xxx-1. XY.duf 

◦ Line 9737: ["uv_set" : 

"/data/db%20xxx/XY/XY/UV%20Sets/db%20xxx/Base/XY3.dsf#XY3",]



• From now on, when this tutorial refers to the “default UVs”, it means your re-wrapped UV 

grid

IV.4.2.3 GeoShell Texture Baking

Section IV.4.2.3.2 will outline the general texture baking process utilizing the example of Golden 

Palace to demonstrate how this process would extend to other GeoShells. However, in section 

IV.4.2.3.1 I will provide you with a Blender Project and respective usage instructions on how to 

bake Golden Palace Textures for any DAZ Character that can simply be imported into UE without 

undergoing the tedious labor in Blender

IV.4.2.3.1 Golden Palace Texture Baking Project

A Blender Project that allows you to create a unique Genitalia Texture out of Golden Palace, Pussy 

Wizard (Labia Majora and Minora Textures) and StereoLove (Anus Textures). These textures, then, 

will be baked onto the Golden Palace UVs and are ready to be used inside UE5

A. Getting Started with the Project

• Download and unzip the attached Blender Project (should work for all versions of Blender 3

up until 3.6)

• Do not change the location of the project .blend file as it refers to said file directory

• Open the project and you will see 3 viewports highlighting different areas of the Genitalia 

texture – feel free to rotate the GeoShell to your need

• Below the rightest viewport is a script panel with the

addon code, press the execute button

◦ Once pressed, you have to wait patiently until the

viewport updates. As many textures have to be

loaded into the project, it might crash or fail to load

individual images – just retry until it succeeded

B. Using the Project

• Once the viewport has updated, a panel will have

appeared on the bottom right-side

• Click the folder icon in the row “Body Skin Texture” to

import the main body skin of your DAZ character

◦ It will be used as a background for the Genitalia Texture so that is blends smoothly with 

the remaining body skin

◦ If your torso texture has a vagina already, in most cases it will be overwritten in a 

satisfactory manner, only the outline may still appear, but you can evaluate that in 

Blender once the texture has been imported

• Play around with the sliders (clicking on the 0 and moving your mouse sideways) to 

examine the effects on the GeoShell’s texture

• You can completely disable certain features/aspects/texture blends



C. Different Texture Types

• Diffuse is quite simple, what-you-see-is-what-you-get

• Specular: Import your torso specular map (or the DAZ Female Base one)

◦ It will only rely on your torso texture, no other setting will affect the process so once the 

texture is baked, it can be used for multiple characters with the same torso skin

• Normal: Quite similar to Specular, but the Labia Majora Wrinkles come with their own 

Normal map as well

◦ Examine the effect of each of the three normal maps and decide for yourself

D. Baking the Texture

• Once your happy with what you see, press the button “Start Baking”

• This will take between 2 and 5 minutes and there won’t be a progress bar shown

• Once the texture is ready, it will be saved in the project directory in the folder 

“BakedTextures” with respective naming conventions

• Every texture gets baked in 4K resolution as scaling it down afterwards results in a higher 

quality than baking it at low-res in the first place

• The respective texture can be used like the Body Texture inside UE just applied to the 

Genitalia material slot

IV.4.2.3.2 Manually Baking a GeoShell Texture inside Blender

The first step in the texture baking procedure is to have one mesh with both UV Maps onto it. Since 

Daz Studio 4.21 this entire process can be sped up drastically 

• Inside Blender, the “Ghost GeoShell” will be parented to an empty axis named 

“GoldenPalace_Shell”

Check whether it is the correct mesh

• With this mesh (not the axis) selected, navigate to the “UV Editing” tab in the top bar of 

Blender

• Make sure that no vertices are selected (nothing highlighted in orange) and from “Material 

Properties” (bottom right panel), select the vertices of each material slot that corresponds to 

the GeoShell

• In the left window, a very densely packed grid should appear roughly where you’d expect 

the GeoShell textures to be on the body skin

=> These are the default UVs that we need to blend with the Golden Palace one’s

• Select your main character shape (“Genesis8_1Female.Shape”, right below the green 

armature in the top right panel)



• Navigate to the “Object Data Properties” panel (green triangle in bottom right panel) and 

expand the sub-menu “UV Maps”

• Rename the current one by double-clicking it to include a reference to GoldenPalace

• Next, add another UV Map by hitting the + icon right to the panel and name it “Default”

• Making sure that the second, newly-created UV Map is selected (highlighted in light gray), 

shift-click the “Ghost GeoShell” mesh in the top right scene outliner

→ Make sure to not select the empty axis instead

• With your mouse hovered in the 3D Viewport, hit “Space” and search for “Transfer UV 

Maps” and apply by pressing enter

=> Check whether it has worked by following the same approach outlined above but shifting

between both UV Maps by clicking on them. If it is correct, the UV Map Grid will change 

from dense to wide between the UV Maps

A. Setting up the GeoShell Material

The next step in the texture baking process is to mimic the blending material inside Blender

• In “Object Mode”, select your mesh with both UV Maps

• Navigate to the “Material Properties” tab in the bottom right menu and switch to object 

mode by hitting "Tab" with your mouse hovered in the 3D Viewport

• Follow the instructions in section IV.3.1 to merge all GeoShell materials into one material 

slot

• With all vertices of this newly-created material slot selected, hit Spacebar and search for 

"Separate" -> "Selection"

=> Delete any other mesh in the scene so that only the GeoShell remains

• Delete all materials on the mesh except the newly-created GeoShell one

• From the top bar, navigate into the "Shading" tab and find your materials node tree in the 

middle-bottom window that looks like a UE Blueprint graph

• Delete all nodes except the material output

• Right-click into the empty material node editor, hit “Spacebar” and search for “Image 

Texture” and place the node by left-clicking

• Press the image icon left to “New” and select your torso texture

• Textures named “d” + some number are the nipple textures and can be chosen as we 

only need the lower part of that texture anyway

• Next, add another node “Add → UV Map” and plug the output “UV” into the input “Vector”

of your image texture

• In the UV node, choose your DAZ default UV Map

• If you haven’t named it properly, go back to “UV Editing” and check its layout

• Create a “Diffuse BDSF” node and plug the “Color” output of your texture node into the 

“Color” input

• Box select all nodes, press “Ctrl + C” and then “Ctrl + V” and left-click-drag the copied 

nodes to a different place



• Change the texture to the GeoShell one (here: GoldenPalace Diffuse Color) and the UV Map

to the one of the GeoShell

• Add a “Mix Shader” node and connect the “BSDF” output of both nodes respectively 

• Now add another “Image Texture” node and select the Opacity Mask of your GeoShell

◦ In Case of Golden Palace, it doesn’t get imported so you have to find it in [...]\DAZ 3D\

My DAZ 3D Library\Runtime\Textures\Meipex\M_GoldenPalace

◦ It comes with three different ones so test each one and select the one you like best

◦ Just drag the texture from your File Explorer into Blender’s material node editor and it 

will create the respective node

• Connect the Opacity Mask into the “Fac” input of your “Mix Shader” node

• Lastly wire the output of the Shader Mix Node into the “Surface” input of the Material 

Output Node 

• If the GeoShell looks weird in the 3D Viewport above the material node editor, make sure 

that the “Blend Mode” and “Shadow Mode” of your material (bottom left panel under 

“Settings”) are set to “Opaque”



• You might need to change the sequence of both “Diffuse BSDF” nodes that are wired into 

the “Mix Shader” based off your Opacity Mask

B. Texture Baking

• Create a new “Image Texture” node, but this time, create a “New” texture with a name and 

resolution of your needs

◦ Bake the texture in 4K resolution, even if you need less because down-scaling it later 

will yield a higher quality than baking it in low-res in the first place 

• Make sure that the GeoShell UV Map is selected for your GeoShell (not only highlighted in 

lighter gray, but also enable the little camera icon right to its name)

• Go to the “Render Properties” tab in the bottom right panel (first entry, camera symbol)

• Change the “Render Engine” to Cycles (Eevee rendering is not supported as of Blender 3.3) 

and the “Device” to “GPU Compute” (to reduce the rendering time)

• Adjust the following settings under “Sampling” → “Render”

◦ Max Samples: Value should be at least equal to your resolution (1920x1080 means max 

samples = 1920), but too high numbers will be canceled by the noise threshold anyway



◦ Time Limit: Doesn’t work as intended, it rather limits the total baking process than 

setting an actual time limit

▪ Setting the Min Samples to 1 (0 = auto-determined by noise threshold if enabled) 

seems to help, but the baking time still exceeds the time limit

▪ Value of 120 seconds in conjunction with noise threshold of 0.0001 and max samples

of 8192 yielded a total baking time of ~7 minutes

◦ Denoise: Will speed up rendering significantly, but also reduces the details of your 

texture. I recommend disabling this feature and using the time limit instead for higher 

quality textures

• In the sub-menu “Bake”, select “Diffuse” as the “Bake Type”

• Disable “Direct” and “Indirect” lighting under “Influence → Contributions”

• With your GeoShell selected in the 3D Viewport and the image texture node with your 

generated empty image selected as well, hit “Bake”

=> When the baking is complete, you will see your texture in the tiny window to your left 

(use mouse wheel to zoom out)

• Navigate to the “Texture Paint” tab in the top bar and click on “Image*” in the top bar of the

left window and choose “Save As…”

◦ Keep the option “Save As Render” disabled as it will alter the textures brightness

◦ If saving as a .png, keep the “Color Depth” to 8 as it will significantly lighten the texture

inside UE5 otherwise

=> This will be the texture we are going to use in your material in Unreal Engine

• Repeat the exact same process with the Roughness textures and Normal Maps to get the best

result in UE5 (very subtle improvement, only noticeable in close-ups)

◦ Alternatively, use the Golden Palace textures instead

Thats it for the texture baking, you can save the project for future texture bakes, but you do not need

anything else from it 



IV.4.2.4 Important Adjustments

Due to the setup of the GeoShells, certain “mistakes” are made when exporting the DAZ character 

to .fbx files. Most prominently, these are weight paint issues causing bone movements to affect 

unrelated areas of the mesh. Unfortunately, there is no clean manual way of doing so wherefore I 

have included the Python code in the respective section

IV.4.2.4.1 Golden Palace Hip Vertex Group Adjustment

• The Golden Palace GeoShell will add a new vertex group to the character by the name of 

“hip” with corresponding weights that slightly but visibly distort animations

◦ Vertex groups are named like the corresponding bones and store information about 

bending behavior of the mesh when a bone gets transformed

◦ Even though the hip bone exists on DAZ Vanilla characters, it doesn’t have a vertex 

group as it is not intended to influence mesh deformation

• With your main character shape selected, enter “Edit Mode”

• In the “Object Data Properties” (green triangle in bottom right panel), select the vertex 

group “hip” and simply delete it by pressing the hyphen (“-” sign) right to it



IV.4.2.4.2 Dicktator Thigh Vertex Group Adjustments

• For whatever reason, the four “Thigh” related vertex groups (left/right & twist/bend) assign 

weights to the “Glans 7” vertices on the mesh causing the Glans to bend unnaturally 

whenever the thighs are animated

• Simply un-weight-painting the “Glans 7” area might be an option but due to the shape of the

mesh, it is highly unlikely to catch all vertices 

• With your main character shape selected in Object Mode, paste the following code into a 

new text document in the “Scripting” tab (top bar) and hit the “Execute” (arrow) button

◦ The script will fetch all vertices that belong to the material slots “Glans” and “Shaft” and

then check if the listed “Thigh” vertex groups have any weights and if so, set these to 

0.000 so animations of the legs won’t affect the Glans anymore



import bpy

obj = bpy.context.active_object

lst_vertex_groups_names = ["lThighBend", "lThighTwist", "rThighBend", "rThighTwist"]

lst_vertex_groups_indices = []

for j in obj.vertex_groups:

    if j.name in lst_vertex_groups_names:

        lst_vertex_groups_indices.append(j.index)

        print("Added to List: ", j.name, ", ", j.index)

#select all vertices of mat slots "Glans" and "Shaft"

bpy.ops.object.select_all(action='DESELECT')

obj.select_set(True)

bpy.context.view_layer.objects.active = obj

bpy.ops.object.mode_set(mode="EDIT")

bpy.ops.mesh.select_all(action='DESELECT')

for i in obj.material_slots:

    if i.name == "Glans" or i.name == "Shaft":

        obj.active_material_index = i.slot_index

        bpy.ops.object.material_slot_select()

        

#Go to Object Mode to refresh the data of selection

bpy.ops.object.mode_set(mode="OBJECT")

selected_verts = list(filter(lambda v: v.select, obj.data.vertices))

print("Vertices Selected: ", len(selected_verts))

for i in selected_verts:

    for j in i.groups:

        if j.group in lst_vertex_groups_indices:

            j.weight = 0



IV.5 Increasing Character’s Resolution

DAZ applies a Catmull-Clark subdivision causing the character to appear smooth inside DAZ 

Studio. Even though supported for inside-UE5-created meshes, the editor currently   (v.5.0.3)   does   

not support this smoothing for imported assets. Therefore we must manually apply a subdivision 

surface modifier in Blender. If your character has morph targets, the approach differs slightly and 

is outlined in section IV.5.1. You still need to read the main section to follow along as a Blender 

beginner

• Inside Blender, save the current character

as a .blend project file

=> If you intend to further optimize your

character, follow the instructions in section

IV.6.1.3; Same approach as outlined below,

but different values apply!

• Select the Genesis 8 Shape from the top

right menu and navigate to the “Modifiers”

tab in the menu below

• DO NOT apply the current modifier, just

leave it as it is (will affect bone hierarchy if

applied)

• Click on “Add Modifier” and select

“Subdivision Surface” in the second

column, second half

• Decrease the value of “Render” to 1,

expand the “Advanced” settings and set

“Quality” to 5 and apply the modifier by

clicking on the little arrow on the right (left

to the closing sign) and select “Apply”

◦ A subdivision level of 2 or higher won’t

add significant improvements to the mesh and rather distort it as some regions will 

become extremely dense (see section IV.6.1.3)

◦ Quality set to 5 means that UVs are preserved more precisely (i.e. no texture stretching)

=> Modifier won’t get applied if you have shape keys / morph targets (see next section)

IV.5.1 Applying Modifiers with Morph Targets / Shapekeys

• Download the attached Blender addon and install it accordinly (see section IV.1 for install 

instructions)

• Select the object with the modifier in the scene panel, hit “Spacebar” and search for 'Apply 

modifier for object with shape keys' (alternatively, select this option from the “Object” 

dropdown menu in the top left bar of the 3D viewport)

• Only select the subdivision surface modifier, do not apply the Genesis 8 one as it will 

change the bone hierarchy

=> On average for sub-div level 1, it takes 2.5s per Morph Target, you can follow the 

progress of the script by opening the console window under “Window” → “Toggle Console”

in the top left bar before starting the process

https://forums.unrealengine.com/t/subd-modeling-mode-options/541396/9
https://forums.unrealengine.com/t/subd-modeling-mode-options/541396/9
https://forums.unrealengine.com/t/subd-modeling-mode-options/541396/9
https://forums.unrealengine.com/t/subd-modeling-mode-options/541396/9


• Once the script has executed, export the character as .fbx and close the project unsaved

• Open a blank project, import the .fbx file and work with this new, fresh project

IV.5.2 (Deep Dive) Modifiers and Morph Targets

• Morph targets are variants of (a part of) the given mesh that the modeling software blends in

between – its like having multiple versions of the same mesh even though only one 

character is visible

• Modifying a character (e.g. by increasing its resolution) requires to modify all of these 

morphs in the same way to keep the quality of the blending process

=> This is expensive and inefficient, best is to create the morph targets based on desired 

resolution → Therefore Blender doesn’t support this feature by default

• The script duplicates the entire character for each morph target, applies the modifier on 

everything and then merges all duplicates to get the morphs back onto one character

• These duplication steps are kept in Blender’s memory wherefore the project file will be 

multiple GBs in size, causing the software to become unstable and laggy

• Blender stores its autosaves in your “Temp” folder

◦ Clean up your disk space by navigating to “C:\Users\[Name]\AppData\Local\Temp”, 

sort all files by size and delete the .blend project files as we have the character as .fbx

IV.6 (Deep Dive) Creating Further LOD’s

Level of Details (LODs) are essential in games to minimize the computational requirements. If the 

character is further away from the camera, the engine shouldn’t waste resources trying to render it 

in HQ since it won’t be visible to the player from the distance anyway

By default, MetaHuman bodies come with 4 LODs so we will mimic this approach. 8 LODs (like the

MetaHuman head has) will increase the memory requirements for your game and (in most cases) 

outbalance the benefits of your LOD system

Setting up the LODs in the editor using UE5’s built-in tools is quite easy and straight forward, 

while additionally being optimized for the engine itself. Nevertheless, Simplygon being more 

complicated to set up and less intuitive to use, provides the best results alongside other optimization

methods beyond the scope of this tutorial

IV.6.1 Using Simplygon (AAA standard, free plugin for the editor)

Simplygon will not work with Morph Targets. Keeping the Subsurf Level 2 mesh inside Unreal 

Engine and only using LODs 1 onwards will drain a significant portion of performance and is no 

real option for gaming

IV.6.1.1 Installing Simplygon

• Download the latest version of Simplygon (SDK Installer) from their website

https://www.simplygon.com/downloads


• Select “free license” in the install menu

• Create a Microsoft account (you can use spam mails like tempr.email)

◦ If your accounts keep getting banned, create a Microsoft account with its own email 

address out of your browser and use this one instead

• Once installed, navigate to the folder and find “\Simplygon\10\UE\5.0\Simplygon”

• Copy the content of this entire folder (except the three .ps1 files) into the “plugins” folder of

your project (not engine!)

→ If the folder doesn’t exist, create it in the hierarchy where your “Config” and “Content” 

folders as well as the .uproject file are located (path: [...]/[GameName]/plugins)

• I recommend re-naming the “SimplyUpdate.exe” file to stop its auto-execution as it will 

prompt you multiple times a day to update to the latest version once available and blocking 

its corresponding service won’t have an effect

=> This entire process has to be repeated each and every time you update Simplygon since 

your license will be updated as well hindering the older version to execute at all

IV.6.1.2 Using Simplygon in Unreal Engine

• Inside UE5, ignore the warning that Simplygon throws (wants to be the default LOD 

system, no need to set it as such)

• Right-click in the content browser and under “Simplygon”, create a new “LOD Recipe”

• In the top bar, add the respective skeletal mesh under “Add Mesh”

• Specify the number of LODs in total and select “Reduction Pipeline” for each one in the 

“Simplygon Settings” sub-menu

◦ In the details settings for each LOD, change the “Reduction Heuristic” to “Consistent” to

get the best quality out of the mesh reduction

◦ It is a best-practice to half the total poly count with each LOD, but I personally like to 

reduce the last LOD slightly further 

→ 4th LOD usually has 12.5% of polys of LOD 0, I keep it at 10% since it is the last one,

least to be seen, but most often used if having AI / NPCs in your scene 

◦ If quality is not satisfying enough, you can do the following:

▪ Increase “Progressive Passes” in sub-menu “Repair Settings” to a value of 5

▪ Lower value of “Hard Edge Angle” in sub-menu “Normal Calculation Settings” to 

60 & enable “Repair Invalid Normals”

• Enable all LODs under “Allow Morph Targets” in the bottom left panel



• Hit “Build” in the top bar and wait for the LODs to get generated (takes some time)

◦ If nothing happens, check your output log; if it shows errors most likely you have a 

different license than the plugin requires (i.e. plugin is older version of Simplygon and 

you need to re-download the newest version) 

=> The LODs will be directly applied to your skeletal mesh

• Simplygon keeps failing if I want to generate the LODs out of the skeletal mesh viewer so 

make sure to call it from inside the “LOD Recipe”



IV.6.1.3 Optimize the Quality of Your Character

Unfortunately this setup doesn’t support meshes with Morph Targets as of yet

Problem: DAZ character with subdivision surface modifier of level 1 is still somewhat edgy in 

renders, but level 2 can’t be handled well by the engine (throws undesired shadows) due to uneven 

poly distribution. We need to increase total number of vertices and additionally re-mesh the 

character.

DAZ Character in Blender with subdivision surface modifier level 2 applied and reduced back to a value that level 1

would provide. While UE5 simply reduces the number of vertices, Simplygon actually remeshed the character

Is it worth it? Reducing the total triangles count from ~116k (subsurf lvl 1) to 100k didn’t just 

lowered the .fbx file size (5.5 MB → 5.4 MB), it also visibly smoothed the edges of the character. 

However, it is a lengthy process of manual labor that solely the first LOD benefits from. All 

subsequent LODs won’t be significantly improved compared to the LOD generation with Simplygon

inside UE5

DAZ Character Close-up with Subdivision Surface Modifier Level 1 applied



DAZ Character Close-up with Subdivision Surface Modifier Level 2 applied and re-meshed to 100k

triangles (Subsurf Lvl 1 has 115k). Please notice the significant adjustment of the nipple shape due 

to the fact that this area is most dense and Simplygon assumes its re-meshing should take priority 

DAZ Character Close-up with Subdivision Surface Modifier Level 2 applied and re-meshed to 150k

triangles (Subsurf Lvl 1 has 115k)



• In your main version of Blender, apply a “Subdivision Surface” modifier with value of 2 in 

categories “Viewport” and “Render” on your main character shape or choose a value of 2 in 

the add-on panel

• Export the character as an .fbx and import it back to the older version of Blender (might take

a minute or two)

• Under “Edit” → “Preferences” → “Addons”, the first entry of that list should be 

“Simplygon 10”, activate it and you will see a tab in the sidebar of the 3D Viewport (press 

“N” to show/hide the sidebar)

◦ If not, navigate to your Simplygon folder, and open the folder “Python”

◦ Blender 2.93 uses Python 2.7 so open that folder and copy all its contents to “[...]\

Blender 2.93\2.93\python\lib\site-packages\simplygon10”

◦ Back in the main root of Simplygon, open the folder “Blender” and copy its content to 

“[...]\Blender 2.93\2.93\scripts\addons\simplygon_10_addon”

• Select your character (not the armature), open the Simplygon tab and click on “Add LOD 

component”

• Select “Advanced” → “Reduction” and expand the “ReductionPipeline” and 

“ReductionSettings”

◦ You can either hover over the info texts to see them or change the X size of the panel by 

dragging it into the 3D Viewport

• Drastically reduce the “ReductionTargetTriangleRatio”

◦ Mesh with subdivision level 1 will have ~116k polys, with subdiv level 2 ~464k, 

therefore the “Triangle Ratio” of LOD 1 is 116/464 = 0.25

◦ Since the mesh will get a more balanced poly distribution, setting its target ratio to 0.215

(results in 100k triangles) will enhance both, quality and performance

=> Disabling the option “ReductionTargetTriangleRatio” and enabling the option “ 

ReductionTargetTriangleCount” right below it allows you to set a given number of 

triangles yourself. However imposing such an inflexible constraint onto the algorithm 

seems counter-intuitive in terms of quality, but I couldn’t see a visible disadvantage so 

far

• Change the

“ReductionHeuristic”

(second dropdown menu)

from “Fast” to

“Consistent”

• Make sure that “Selected

meshes:” only lists the

name of your character

and click “Process”

=> You will notice that the

bones look tilted on the

newly created character so

we have to bind it to the

previous ones



• In the scene panel (top right side), expand the “Genesis8_1Female.001_LOD1” and select 

the “[…].Shape.001_LOD1” object

• Ctrl-click the main armature of the original “Genesis8_1Female” (where the other shape is 

parented to) and hit “Spacebar” inside the 3D viewport

• Search for “Make Parent” and select “Object (Keep Transform)”

• If it creates a pointer

(your mesh is not

parented to the

armature properly in

the scene outliner),

drag and drop the

mesh onto the

armature

• With the newly optimized mesh selected, navigate to the “Modifiers” tab (blue spanner in 

bottom right panel) and add a modifier "Data Transfer" (first top left) 

◦ As "Source" select your main character shape object

◦ Enable "Vertex Data" and expand its sub-menu

◦ Inside, select "Vertex Groups" and under "Mapping", choose: "Nearest Face 

Interpolated" 

▪ There are more faces on the object than vertices so mapping will be more precise; 

however if you conducted a major reduction (50% or more), you might get better 

results choosing "Nearest Vertex" 

◦ Ensure that in the sub-menu "Vertex Groups" -> "All Layers" are selected under "Layer 

Selection" 



◦ Hit the button "Generate Data Layers" at the very top of the modifier (fifth entry from 

the top) and then apply the modifier 

• Delete all other “LOD1” objects in your

scene panel as well as the original

“[…].Shape” object as we have now

replaced it with the optimized mesh

• With the new mesh selected, navigate to

the “Modifiers” tab (blue spanner in

bottom right panel) and connect the

existing modifier to the armature

◦ If it doesn’t exist, create a new

“Armature” modifier

• Export the entire character as .fbx file as

described in section IV.  7   and follow the

instructions in section IV.6.1.2 to

generate LODs for this new mesh



IV.6.2 Using Unreal’s Mesh Reduction Tool

• Inside UE5, enable the plugin “Skeletal Mesh Simplifier (Early Access)”

• In “Project Settings”, set “Skeletal Mesh Reduction Plugin” to “SkeletalMeshReduction”

• Open up a skeletal mesh and expand the sub-menu “LOD Settings” in the “Asset Details” 

panel on the left

• Set the “Number of LODs” to your desired value and hit “Apply Changes”

→ This will take a moment

• After that, the “Reduction Settings” and “Build Settings” of the menu “LOD 0” should be 

expanded 

◦ Optionally, enable “Remap Morph Targets” if you have any and hit “Apply Changes”

=> Most changes made in LOD 0 will be automatically transferred to subsequent LODs

• You can modify the settings for each LOD individually by either selecting it from the 

viewport or by enabling “Custom” mode in the menu “LOD Picker”

◦ “Percent of Triangles” and “Remap Morph Targets” are the most important values



IV.7 Exporting from Blender to UE5

• Once you are done with all optimizations, all you should be left with is the main 

Genesis8Female.Shape object including the armature – all other meshes must be deleted as 

we don’t need them anymore

• Export   the asset from Blender in .fbx format using the following settings (can be saved as 

present)

◦ Under “Include” → “Limit To” → Only enable “Active Collection”

▪ “Object Types” = “Empty”, “Armature”, “Mesh”, “Other”

◦ Under “Transform” → disable “Apply Unit”

◦ Under “Geometry” → “Smoothing” = “Face” and disable “Apply Modifiers”

◦ Under “Armature” → Disable “Add Leaf Bones”

◦ Disable “Bake Animation”

• Import   the .fbx file to UE5 with the following settings

◦ Skeleton: Choose the modified GoldenPalace Skeleton downloaded from sections IV.1.1 

or IV.2

◦ Enable: “Skeletal Mesh” & “Import Mesh” (as a preview asset is needed)

◦ Under Advanced: enable “Create Physics Asset”, enable “Import Morph Targets” and set

“Normal Import Method” to “Import Normals and Tangents”

Disable “Import Animations” (as we have none) as well as “Import Textures” (as we have the Iray 

materials created by the Bridge already)



V. MetaHuman Head

This entire chapter is dedicated to the creation and modification of MetaHuman heads. If you 

intend to use a DAZ head you can safely skip this entire chapter

The benefits of using MetaHuman heads are the ease of creating, modifying and animating them. 

Poses can easily be saved and applied to other heads and the extensive and intuitive control rig 

feature enables everyone to quickly setup facial expressions. Lastly, tools like the MetaHuman SDK 

make the heads game ready by creating Lip Sync animations based on given auditive input. 

However, as outlined in the beginning, there will be a non-seamless transition between the neck and

head (DAZ skin to MetaHuman one). 

Before downloading your MetaHuman to UE5, make sure to read about the skin tone and texture 

settings in section VI.2.3 to save you some effort down the line.

V.1. Mesh to MetaHuman (Head Generation)

You can create a MetaHuman from scratch, but as this process is very straight-forward, I will be 

focusing on different face-retargeting approaches. Please be notified that not all face shapes are 

supported and that the results are not always similar to the given input. In particular, I’ve 

discovered that Asian faces are rather unsupported, but a generated head yields a great starting 

point for manual tweaking

The retargeting operation allows to create heads outside the MetaHuman library causing slight 

distortions and inferior animations. In the MetaHuman Creator (MHC), examine these problems by

enabling the Facial ROM animation. Reducing the influence of the custom mesh on the specific 

body part (eyes and mouth are most critical) will make the distortions less visible. However, inside 

UE5, the MetaHuman Facial Control Rig offers various controls to tweak and fix any issues (like 

the pupil poking through the closed eye lid)

V.1.1 (Deep Dive) Mesh to MetaHuman Settings

This section describes all available settings for the MetaHuman Identity Solve process. I haven’t 

perceived any noticeable improvements from using more than the default trackers, but you may 

want to experiment with different shaping options (like Elven ears) or get a general understanding 

of the individual options

Since there is no official documentation on these advanced features, I will outline the most intuitive 

approaches for each setting. However, I have also seen tutorials taking an entirely different concept

still yielding the desired results. This is most often the question of front or side-view: Both, the 

mentolabial fold and the outer ear helices have been marked/tracked in any of these ways

When adding a non-default marker, it either is already pre-placed or placed far away from the 

actual image. If you can’t see it immediately, scroll out until you see it. Drag the entire spline by 

clicking on the line and not one of the dots. Hold down shift to box select



Recommended Camera Settings

• Change the focal length of your camera to a value of 20 or 25

• Use “Unlit Mode” for the auto-tracking, but “Lit Mode” for manually placing the trackers

• Get a full-front view of the camera

◦ Camera transform can be found in the bottom left panel when “Neutral Pose” is selected

◦ “Frame Promotion” → “Promoted Frames” → [Current Frame Number] → “Camera 

Transform”

◦ Make sure that the X location is 0 and there is no rotation other than the -90° on the Z 

axis

Brow Markers

• Use: Create a custom shape of your eye brows.

Will cause stretching of MetaHuman’s presents

and deteriorate their quality

• How to Align: Place the line right in the middle of

the current eyebrows following their unique shape.

The density of the dots doesn’t seem to make a

difference



Eye Crease Markers

• Use: Apply different shapes to your eyes that MetaHuman Creator doesn’t support by 

default (as of yet). Very useful for creating Asian characters

• How to Align: It starts at the outer end of the eye,

but doesn’t go until the inner end, it stops a little bit

before that



Plica Semilunaris Markers

• Use: To define the fleshy part at the inside of your

eyes. No customization options in MHC and

influence is bound to overall eye region

• How to Align: It must be overlapping with the

markers for “Eyelid Lower” and “Eyelid Upper” ,

but shall not exceed them



Outer Eyelid Markers

• Use: Create sharper, more highlighted eyes. Especially common for Asian people

• How to Align: It might be rather obtrusive to model both, the upper and lower outer eyelids.

Placing just one of them will yield the desired look while the MHC extrapolates the 

corresponding part internally. If the outer eyelids are not visible in your character but you 

still want to have them, try to resemble them as close as possible



Mentolabial Fold Markers

• Use: To determine the spacing and shaping between lips and chin. (Most likely) attributed to

the chin area and draws from its overall influence

• How to Align: It seems that it should be placed based on the front view. Even though being 

upward shaped, downward shaping is also supported (and needed for many characters)



Nostril Markers

• Use: To enhance the shape of the nose

• How to Align: Usually is auto-tracked even though disabled by default. Nostrils will only be

visible in “Lit Mode”

Ear Markers

• Setup: The official Unreal tutorial used a side-view for the ear shape, but others have been 

using the front-view and it still worked just fine. In case you go for the side-view you need 

to promote two additional frames and focus each ear individually. Position the camera in the 

exact same angle for each ear. Auto-tracking for the ears only doesn’t work. Make sure that 

on the left hand panel the option “Use to Solve” is enabled under “Frame Promotion” → 

“Promoted Frames” → [Your current frame]

• How to Align: Shift-select all markers and place them as best as you can to minimize 

manual effort





V.1.2 Stylized Head Models (Sims 4 Character Heads)

An example of how to turn stylized Sims 4 Characters into MetaHumans. Quality can be 

(significantly?) improved by manual tweaking. Will work with other characters too (like stylized 

DAZ characters, Disney figures or toon characters)

Example MetaHumans



• Download the Sims 4 Ripper

• Launch The Sims 4, press “New Game” and either (i) add your Sim to a new household, (ii) 

create a new one or (iii) create a random one if you intend to download a pre-made Sim

• Set the name and the traits of your character and click proceed

• Move your household into a slot (i.e. place your household actually into the world)

• Let the game  run for at least one in-game minute (i.e. un-pause the game as it is paused by 

default)

• Go into the “Manage Worlds” menu (don’t save!) and click on “Manage Households”

• (Optional) Navigate to the tab “Other Households” and transfer the pre-made Sims to your 

household that you want to export (and get rid of your created Sim if not needed)

=> Deleting all other households will make it easier to find yours in the Ripper, but takes a 

lot of time…

• Once you are done, go back to the game mode with your already placed household

• Hit “Escape” and leave the game (save here now!)

• Unzip the TS4SimRipper and launch the .exe file (will take a few moments without any 

visual feedback)

• Click “Setup” in the top bar and assign the respective game directories and hit “Save”

◦ TS4 Game installation folder: “D:\Games\The Sims 4\Game\Bin”

◦ TS4 SDX content folder: “D:\Documents\Electronic Arts\The Sims 4\content”

◦ TS4 user Mods folder: “D:\Documents\Electronic Arts\The Sims 4\Mods”

◦ TS4 user saves folder: “D:\Documents\Electronic Arts\The Sims 4\saves”

• Click the “Select” button and find your save game file

• On the left hand panel, deselect everything except “Human”, [Your Gender] & [Age Group]

• Before selecting your Sim, choose “HQ” under “Texture Size” and from the drop down 

menu, select “all separate meshes, one texture”

• Select your sim and wait until its loaded

• Export the Sim by selecting “Save As:” “DAE” file

https://modthesims.info/d/635720/ts4-simripper-classic-rip-sims-from-savegames-v3-13-2-0-8-15-22.html


• Open Blender, click into the 3D viewport (to get rid of the welcome window), press “A” to 

select every object in the scene and hit “delete”

• Import the Sim into Blender



• In the panel on the right, expand the “rig”, select “pose” and hit “delete”

• Now delete every object except “Head” and “Top”

• Select “Top” first and then ctrl-click “Head” and press “Ctrl + J” in the viewport to combine

both objects

• With the new object selected, switch to “Edit Mode” from the drop down in the top left 

corner (shortcut: Tab) and right-click into the viewport to deselect everything (i.e. nothing is

orange anymore, all black now)

• Toggle X-Ray Mode by clicking on the icon in the top right bar of the 3D Viewport (hover 

over it to see info, shortcut: “Alt + Z”)

• Box select the head and as much of the neck as possible excluding the shoulders

• Press “P” and choose “Separate Selection” to create a new object

• Switch back to “Object Mode”, delete the old object (new one is called “[Old name].001”) 

and export the file as .fbx using the settings outlined in section IV.7

• Import into UE5 by enabling “Import Textures” (may or may not help the Identity Solve, 

depends on the individual context)



V.1.3 Realistic Head Models (DAZ Character Heads)

Just a few tips and tricks to quickly isolate the head & neck inside DAZ Studio to get it into UE5

• Inside DAZ Studio, setup the head that you want to re-target to a MetaHuman, remove any 

hear, eyebrows, tears or other attachments

• Switch to the “Geometry Editor” under “Tools” in the top left toolbar (shortcut: 

Alt+Shift+G)

• Right-click in the 3D viewport and change the “Selection Mode” to “Marquee Selection”

• Furthermore change “Selection Type” to “Polygon Selection”

• Drag a box that captures the entire head in order to highlight the corresponding polys

• Right-click in the 3D viewport, “Geometry Selection” → “Select By …” → “Regions” → 

“Neck” to select all the neck polygons

• Right-click → “Geometry Selection” → “Invert Selection”

• Right-click → “Geometry Editing” → “Delete Selected Polygon(s)”

• Send the character to UE5 with the DAZ bridge as “skeletal mesh” (static mesh will have 

very low resolution) and set subdivision level to 1



VI. MetaHuman Adjustments in UE5

This chapter is mostly focusing on MetaHuman-related adjustments. A detailed setup of the DAZ 

textures can be found in this tutorial

VI.1 Socket the MetaHuman Head onto the DAZ Body

• Create a socket “Socket_MH_Head” on the “Upper Neck” bone of your skeletal mesh

• Attach the MetaHuman Head as a preview asset and change the positioning of the socket

• The following values are working just fine if following this tutorial and keeping a head scale

of 100%

Relative Location 0.035 147 -1.35

Relative Rotation -90 0 0

VI.2 Reducing the MetaHuman Neck Length

We will create this inside the main material allowing to make adjustments on the fly which can be 

useful for cinematics or rendering as some animations or camera angles might showcase the 

neckline

• Open the face mesh of your MetaHuman and browse to the material in the 0th slot 

“MI_Head_synthesized_Baked”

• Open it up and from the hierarchy, select the master material “M_Head_Baked”

• Create a security copy of this material (“M_Head_Baked_Vanilla”)

• In the main material, change “Blend Mode” to “Masked” to get access to the “Opacity 

Mask” input pin

• Create a “Linear Gradient” node and connect the “VGradient” output to a “One Minus” 

node and wire it into the “Opacity Mask” pin



• Create a Material Instance of this main material “MI_Head_Baked_Master”

• Inside, scroll down to the bottom and under “Material Property Overrides”, enable “Opacity 

Mask Clip Value” and change it down to 0.2

◦ Value of 0.0 means full visibility of the neck

• In the same folder (“MetaHumans” → “Common”) are three other MIs 

(“MI_Head_Synthesized”, “MI_Head_Synthesized_LOD1” & 

“MI_Head_Synthesized_LOD2”), reparent them to the new Master MI

=> This way we can control the clip value (visibility of the lower parts of the neck) for all 

LODs simultaneously instead of having to change the value three times in three different 

MIs.
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